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Introduction 

The purpose of this session is, following on from the online survey, explore your 
capabilities with intermediate and some more advanced features within Excel 
through completing a series of activities.  Tips and reminders and guidance are 
included in the booklet.   
 
You are encouraged to make notes as and when required in the booklet which is 
yours to keep.  The subject matter is not exhaustive or restricted, as it is designed to 
meet YOUR requirements.  Any areas covered which are not included in this booklet 
will be provided in a supplementary document and revisited in the event of any 
subsequent sessions.  
 
Where you see the Tip icon, this gives you suggestions for alternative 
ways to complete a function. 
 
You will be given a ‘developing’ electronic version of these notes so you can easily 
find information, and at the end, there is a list of keyboard shortcuts covering a range 
of Excel functions. 
 

Introductory Activity 

You have been given a spreadsheet called – production07.xls on your desktop. 
 
Complete the spreadsheet so that it looks exactly like the table on the next page 
while adhering to the following points:  
 
1. Complete all the missing totals using appropriate formulae 
2. Add an internal singular border and external double border.  Make all fonts 

Arial size 10 
3. Use Conditional Formatting to make all cells containing no information a 

colour of your choice 
4. Make all headings and totals bold 
5. Set row height in all cells to 25 
6. Column A should be 21 in width, Columns B to H should be 8.57 in width 
7. Set all cells to vertical centre alignment and wrap text 
8. Merge the cells in row 17 
9. Add a document header - Activity One, Tracking Stock 
10. Add a document footer – date on the left, page number in the middle and 

filename on the right.  
11. Set the print area so only the table is printed and appears on a single page at 

100% 
12. Name the worksheet ‘First 6 months’ 
13. Create a new worksheet and call it ‘Second 6 months’ 
14. Change the tab colours of each sheet to two colours of your choice 
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Production Jan-07 Feb-07 Mar-07 Apr-07 May-07 Jun-07 
Grand 
Totals 

Product A 3,500 8,000 4,500 3,546 4,500 7,280   

Product B 2,500 4,678 4,462 2,654 4,468 4,654   

Total Production 6,000 12,678 8,962 6,200 8,968 11,934 54,742 

                

Stock holding               

Carried forward               

Product A 600 204 1,829 433 94 935   

Product B 700 325 293 525 303 61   

Total Stockholding 1,300 529 2,122 958 397 996 6,302 

                

Sales               

Product A 3,896 6,375 5,896 3,885 3,659 7,254   

Product B 2,875 4,710 4,230 2,876 4,710 3,895   

Total Sales 6,771 11,085 10,126 6,761 8,369 11,149 54,261 

                

Stock remaining (carried 
forward) 

              

Product A 204 1,829 433 94 935 961   

Product B 325 293 525 303 61 820   

Total Stockholding 529 2,122 958 397 996 1,781 6,783 
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Merging Cells 

To merge cells, firstly, select the range you want to merge (NB:  If you merge cells 
containing data, all the data will be deleted apart from the originating cells)  
 

 
Figure 1: Cells selected for merging 

 
 
Select the ‘merge and center’ icon from the toolbars – and you cells will 
automatically merge.  
 
If the icon appears unavailable, you can merge cells using the format cell option 
 

 
Figure 2:  Format Cells Window 

 
Select the ‘Alignment’ tab and check the box ‘merge cells’ under the text control 
heading 
 

 
Figure 3: Merge cells selected in alignment window 
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Figure 4:  Cells merged 

 

Conditional Formatting 

Conditional formatting is a very useful method for highlighting specific features in 
Excel cells, for example, if you are looking at a large spreadsheet and wished to see 
all cells containing a value higher than £500.  You are allowed to set up to a 
maximum of THREE conditions on any cell.   
 
First – select the area you wish to add the conditional formatting to 
 

 
Figure 5: Selected area 

 
Then select the Format menu, and select ‘Conditional Formatting’. 

 

 
Figure 6:  Conditional Formatting menu 

 
You can now set your criteria by which you want to measure the cells for 
highlighting.  You can choose between Cell Value and Formula 
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Figure 7:  Conditional formatting options 

 
And then specify your criteria: 
 

� Between 
� Not Between 
� Equal to (NB:  For conditional formatting purposes, a cell will be considered 

as ‘equal to Zero’ if it is blank).  
� Not equal to 
� Greater than 
� Less than 
� Greater than or equal to 
� Less than or equal to 

 
Once you have decided which formulae you wish to apply to a cell, you can then 
decide how you want to identify it, this could be by changing the cell colour, font 
colour or by placing a border around the cell. 

 

 
Figure 8:  Conditional formatting style options 

 

Setting Row Height 

When you open Excel, all cells are set to a standard height of 12.75.  You can set 
your row height to whatever you feel suitable, or you can set the cells so that the 
height will automatically adjust to fit the size of the content 
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Figure 9: Row Height 

 

 
Figure 10: Change row height 

 
Alternatively, you can select Autofit  
(this will automatically resize the row height to fit the contents – useful if you have 
multiple lines of wrapped text of are using a large font size) 

 

 
Figure 11: Autofit (Row) 

 

Setting Column Width  

When you open Excel, all cells are set to a standard width of 8.43.  You can set your 
column width to whatever size you feel suitable (up to a maximum of 255), or you 
can set the cells so that the width will automatically adjust to fit the size of the 
content. 
 

 
Figure 12: Column width 
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Figure 13: Column width 

 
 

 
Figure 14: Autofit column width 

 

 

You can ‘autosize’ a row or column by double-clicking the line 
alongside the cell you wish to resize 

 
 

Cell Borders 

Firstly, select the cells you want to place the borders around: 
 

 
Figure 15:  Excel cells selected 

 
Then select cells from the Format menu (or press Ctrl + 1) 
 

 
Figure 16: Format Cells 
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Then select Borders 
 

 
Figure 17:  Border options 

  
 
 From here, you can change the cell borders to any of the displayed options, 

for example, a single border inside and a double border outside. 
 

 
Figure 18: Excel cells with double outside border and single inside border 

 
 

Editing Worksheet Tabs 

If you are working in a spreadsheet with multiple worksheets, it can be useful to give 
them meaningful names rather than Sheet 1, Sheet 2 etc 
 
Using the mouse, right click on the worksheet you want to change.   
 

 
Figure 19:  Worksheet editing options 

 
You can see from this menu, you can insert, delete, rename, move or copy the 
worksheet, or change the tab colour. 
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Insert simply adds another worksheet, whereas delete will remove the selected one 
(NB: if you delete a worksheet, this cannot be undone).  You will always be 
presented with a window asking you to confirm you wish to delete the sheet.   
 
Here, we have selected ‘Rename’ and changed Sheet 3 to ‘Production A’ 
 
  

 
Figure 20:  Renamed work sheet 

 
And we have changed the tab colour to pink 

. 
 

 
Figure 21:  Changing the colour of a worksheet tab 

 
NOTE:   You will not see the full effect of the tab colour change until you move 

to a different worksheet 
 

 
Figure 22:  A coloured tab 

 

 

You can edit a worksheet tab by double clicking on it using the left 
mouse button 
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Headers and Footers 

Headers and Footers can be useful ways to identify and track documents and 
enhance their professionalism.    They are simple to do in Excel, but can be 
restrictive in terms of positioning. 
 
To add a header and / or footer, select ‘Page Setup’ from the file menu 
 

 
Figure 23:  Page Setup on File menu 

 

 
Figure 24:  Select the Header / Footer Tab 
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Figure 25:  Footer Set-up 

 
 
 

 
Figure 26:  Footer output 

 

AutoSum Options 

The AutoSum function is most commonly associated with calculating the total of the 
numbers in the adjacent cells (above or alongside)  
 

 
Figure 27: Autosum icon 

 

 
Figure 28: Auto-sum of numbers 

 
As well as adding together rows of numbers, by using the drop down menu 
(activated by the arrow) alongside the AutoSum icon, it will also calculate (default 
setting) the 

 



Excel – Intermediate / Advanced 
 
 

 
16/08/2010 14 Excel_intermediate 

� Minimum number in a range 
� Maximum number in a range 
� Count how many numbers are in a range and  
� Work out the average of a range  

 

 
Figure 29: AutoSum options 

 
 

Activity Two 

Activity 2 tests your use of the most common AutoSum functions.  Activity 2 Finished 
shows what your answers should be. 

Linking Worksheet Data 

A useful feature of Excel is its ability to automatically update data copied from 
another cell or worksheet; this avoids the need to revise large amounts of 
information if, for example, your sales projections or production capacity for a 
specific product changes. 
 
The simplest way to add a single figure is to enter the + sign in the cell you want to 
include the total, and then go to the worksheet containing the information you 
require, and then simply press the enter key 
 
 

 
Figure 30:  Setting up the cell to automatically copy information 
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Figure 31:  Selecting the cell the data is coming from 

 

You can also take this transfer of information a step further, and use features such 
as Autosum (total, count, average, and minimum, maximum) in the same manner 
 
So a formula for the total of product three for Area 1 would read ‘=SUM('Area 
1'!B5:M5)’ 
 

Activity Three 

Activity 3 is a spreadsheet of five pages with annual sales of four products in four 
different areas.  There is also an Activity 3 finished spreadsheet showing how your 
spreadsheet should look when completed. 
 
Where the spreadsheet contains shaded areas, use appropriate formulae to fill the 
missing amounts 
 
� Use conditional formatting to highlight monthly sales below £1000 and above 

£7500.  When you have finished, try changing different amounts to see what 
happens to the cell 

� Change row heights to 25 – and titles to AutoFit 
� Colour the individual workbook sheets to colours of your choice 
 
 

Count Functions 

Countif 
Countif can be a very useful function if you need to know the number of items that 
meet a certain criteria within a lot of data 
 
A Countif Formula could look like this - =COUNTIF(B1:B14,"<1200") 
 
Here – we want to know how many numbers in a range are below 1200, Five are 
below 

 654 

 3548 
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 24154 

 3214 

 23154 

 1 

 587 

 3547 

 2178 

 21783 

 2477 

 1472 

 145 

 999 

Countif 5 

 
Some people with analytical minds will often try to input relatively complex formulae 
in a cell manually; this can be messy, complicated and frustrating.  Excel offers a 
function insertion facility on the Insert menu. 
 

 
Figure 32: Function Menu 

 

 
Figure 33:  Easy function insert interface  (Countif) 

 
 
Counta 
Counta will count any cell in a range irrespective of whether it contains numbers or 
text 
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 654 

 Test 

 sdf 

 sdf 

 xb 

 1 

 zv 

  

 2178 

 zx 

 2477 

 1472 

 145 

 999 

Counta 13 

 
 
A Counta formula could look like this: =COUNTA(B1:B14) 
 

IF Function 

The IF function can be very useful if you are trying to measure eligibility criteria, for 
example, if you have a sales force team who are paid commission for sales over a 
certain amount. 
 

 Sales Value 
Eligible for 

commission (i.e. 
sales over 5,500) 

Salesman 1 £3,600 No 

Salesman 2 £8,500 Yes 

Salesman 3 £16,000 Yes 

Salesman 4 £7,500 Yes 

Salesman 5 £16,000 Yes 

Salesman 6 £3,000 No 

Salesman 7 £1,658 No 

Salesman 8 £8,000 Yes 

Salesman 9 £16,000 Yes 

Salesman 10 £1,800 No 

 
The above formula could look like this - =IF(B3 > 5500,"Yes","No") 
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Figure 34: If function 

 
Logical Test: We are testing each cell to establish if it is above 5,500 in 

Value 
Value if True: If the value is above 5,500, then the sales person is 

eligible for a bonus 
Value if False: If the value is below 5,500, then the sales person is not 

eligible for a bonus  
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Keyboard Shortcuts 

 

Keyboard Function 

F1 Help function 
F4 Repeat last action 
F7 Spell check 
F8 Start selection (use arrow keys to expand 

selection) 
Ctrl + A Select the entire worksheet 

Ctrl + B Bold 
Ctrl + C Copy 
Ctrl + D Copy the contents of the cell above 
Ctrl + F Find 
Ctrl + G Go to a specific cell reference 
Ctrl + H Search and Replace  

Ctrl + I Italics 
Ctrl + K Insert a hyperlink 
Ctrl + L Create a List 
Ctrl + N Start a new workbook 
Ctrl + O Open an existing document 
Ctrl + P Print 
Ctrl + S Save 

Ctrl + U Underline 
Ctrl + V Paste 
Ctrl + W Close Workbook 
Ctrl + X Cut 
Ctrl + Y Repeat last action 
Ctrl + Z Undo last action 

Ctrl + 1 Format cells menu 
Ctrl + Home Return to the start of the worksheet 
Ctrl + End Go to the end of the worksheet 
Home Go to the start of the row 
End Go to the end of the row 
Shift + Arrow key (any direction) Start selection 
Alt + Enter Start a new line in a cell 

 


